Install ISE on a VMware Virtual Machine

- ISE Features Not Supported in a Virtual Machine, on page 1
- Supported VMware Versions, on page 1
- Support for VMware vMotion, on page 1
- Support for Open Virtualization Format, on page 2
- Virtual Machine Requirements, on page 3
- Virtual Machine Resource and Performance Checks, on page 10
- Obtain the Cisco ISE Evaluation Software, on page 11
- Install Cisco ISE on Virtual Machines, on page 12
- Migrate Cisco ISE VM from Evaluation to Production, on page 24

ISE Features Not Supported in a Virtual Machine

The Inline Posture node is supported only on Cisco SNS-3415 and Cisco ISE 3300 series appliances. It is not supported on Cisco SNS-3495 series or VMware server systems. All the other designated roles are supported for use on VMware virtual machines.

Supported VMware Versions

Cisco ISE supports the following VMware servers and clients:

- VMware version 7 (default) for ESX/ESXi 4.x
- VMware version 8 (default) for ESXi 5.x
- VMware version 11 (default) for ESXi 6.0 (requires Cisco ISE 1.3 Patch 4)

Support for VMware vMotion

Cisco ISE supports the cold VMware vMotion feature that allows you to migrate virtual machine (VM) instances (running any persona) between hosts. For the VMware vMotion feature to be functional, the following condition must be met:
• Cisco ISE must be shutdown and powered off—Cisco ISE does not allow to stop or pause the database operations during vMotion. This might lead to data corruption issues. Hence, ensure that Cisco ISE is not running and active during the migration.

Note
Cisco ISE VM does not support Hot vMotion.
Refer to your VMware documentation for more information on VMotion requirements.

Caution
If the Snapshot feature is enabled on the VM, it might corrupt the VM configuration. If this issue occurs, you might have to reimage the VM and disable VM snapshot.

Note
Cisco ISE does not support VMware snapshots for backing up ISE data because a VMware snapshot saves the status of a VM at a given point in time. In a multi-node Cisco ISE deployment, data in all the nodes are continuously synchronized with current database information. Restoring a snapshot might cause database replication and synchronization issues. We recommend that you use the backup functionality included in Cisco ISE for archival and restoration of data. Using VMware snapshots to back up ISE data results in stopping Cisco ISE services. A reboot is required to bring up the ISE node.

Support for Open Virtualization Format

Cisco ISE supports the Open Virtualization Format (OVF) and offers OVA templates that you can use to install and deploy Cisco ISE on virtual machines (VMs). The following OVA templates are available:

• ISE-1.3.xxx.xxx-evaul.ova—Use this template if you are evaluating Cisco ISE and the evaluation license would support up to 100 endpoints.

• ISE-1.3.xxx.xxx-virtual-SNS3415.ova—Use this template if your VMware appliance specification is comparable with an SNS-3415 appliance.

• ISE-1.3.xxx.xxx-virtual-SNS3495.ova—Use this template if your VMware appliance specification is comparable with an SNS-3495 appliance.

The following table provides OVA template reservations.
Install ISE on a VMware Virtual Machine

## Virtual Machine Requirements

To achieve performance and scalability comparable to the Cisco ISE hardware appliance, the VMware virtual machine should be allocated system resources equivalent to the Cisco SNS 3415 and 3495 appliances.

<table>
<thead>
<tr>
<th>OVA Template</th>
<th>Memory</th>
<th>CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Eval OVA</td>
<td>4 GB RAM (no reservation)</td>
<td>2300 MHz (no reservation)</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>For evaluating guest access and basic access policy flows, a minimum of 4 GB RAM is required. For evaluating advanced features such as pxGrid, internal CA, and SXP, we suggest that you configure your VM to have 16 GB RAM after deploying the Eval OVA.</td>
<td></td>
</tr>
<tr>
<td>Virtual SNS-3415 OVA</td>
<td>16 GB RAM</td>
<td>8000 MHz</td>
</tr>
<tr>
<td>Virtual SNS-3495 OVA</td>
<td>32 GB RAM</td>
<td>16000 MHz</td>
</tr>
</tbody>
</table>
# Table 1: VMware System Requirements

<table>
<thead>
<tr>
<th>Requirement Type</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td></td>
</tr>
</tbody>
</table>
| **Evaluation:**  | • Clock Speed: 2.0 GHz or faster  
|                  | • Number of Cores: 2 CPU cores |
| **Production:**  | • Clock Speed: 2.0 GHz or faster  
|                  | • Number of Cores: 4 (Small) to 8 (Large) CPU cores |

Cisco ISE supports Hyperthreading. You can install ISE on VMware hosts that have the Hyperthreading option enabled or disabled.

**Note** Even though Hyperthreading might improve overall VM performance, it does not change the supported scaling limits per VM appliance. Additionally, you must still allocate CPU resources based on the required number of physical cores, not the number of logical processors.

**Note** Refer to OVA Template Reservations table for CPU Reservations.

<table>
<thead>
<tr>
<th>Memory</th>
<th></th>
</tr>
</thead>
</table>
| **Evaluation:**  | • Basic—4 GB (for evaluating guest access and basic access policy flows) 
|                  | • Advanced—16 GB (for evaluating advanced features such as pxGrid, internal CA, and SXP) |
| **Production:**  | • Small—16 GB  
|                  | • Large—32 GB  |

**Note** Refer to OVA Template Reservations table for Memory Reservations.
<table>
<thead>
<tr>
<th>Requirement Type</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Disks</td>
<td>• <strong>Evaluation:</strong></td>
</tr>
<tr>
<td></td>
<td>• Minimum (only for lab testing; supports about 20 endpoints) — 100 GB</td>
</tr>
<tr>
<td></td>
<td>• Recommended — 200 GB</td>
</tr>
<tr>
<td></td>
<td>• <strong>Production:</strong></td>
</tr>
<tr>
<td></td>
<td>• 200 GB to 1.999 TB of disk storage (size depends on deployment and tasks).</td>
</tr>
<tr>
<td></td>
<td>• We recommend that your VM host server uses hard disks with a minimum speed of 10,000 RPM.</td>
</tr>
<tr>
<td>Note</td>
<td>When you create the Virtual Machine for Cisco ISE, use a single virtual disk that meets the storage</td>
</tr>
<tr>
<td></td>
<td>requirement. If you use more than one virtual disk to meet the disk space requirement, the installer</td>
</tr>
<tr>
<td></td>
<td>may not recognize all the disk space.</td>
</tr>
<tr>
<td>Storage and File System</td>
<td>The storage system for the Cisco ISE virtual appliance requires a minimum write performance of 50</td>
</tr>
<tr>
<td></td>
<td>MB per second and a read performance of 300 MB per second.</td>
</tr>
<tr>
<td></td>
<td>Deploy a storage system that meets these performance criteria and is supported by VMware server.</td>
</tr>
<tr>
<td></td>
<td>Cisco ISE provides a number of methods to verify if your storage system meets these minimum requirements</td>
</tr>
<tr>
<td></td>
<td>before, during, and after Cisco ISE installation. See <strong>Virtual Machine Resource and Performance</strong></td>
</tr>
<tr>
<td></td>
<td>Checks**, on page 10 for more information.</td>
</tr>
<tr>
<td></td>
<td>We recommend the VMFS file system because it is most extensively tested, but other file systems,</td>
</tr>
<tr>
<td></td>
<td>transports, and media can also be deployed provided they meet the above requirements.</td>
</tr>
<tr>
<td>Disk Controller</td>
<td><strong>Paravirtual</strong> (default for RHEL 6 64-bit) or LSI Logic Parallel</td>
</tr>
<tr>
<td></td>
<td>For best performance and redundancy, a caching RAID controller is recommended. Controller options</td>
</tr>
<tr>
<td></td>
<td>such as RAID 10 (also known as 1+0) can offer higher overall write performance and redundancy than RAID</td>
</tr>
<tr>
<td></td>
<td>5, for example. Additionally, battery-backed controller cache can significantly improve write</td>
</tr>
<tr>
<td></td>
<td>operations.</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Requirement Type</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>NIC</td>
<td>1 GB NIC interface required (two or more NICs are recommended). Cisco ISE supports E1000 and VMXNET3 adapters.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>We recommend that you select E1000 to ensure correct adapter order by default. If you choose VMXNET3, you might have to remap the ESX or ESXi adapter to synchronize it with the ISE adapter order.</td>
</tr>
<tr>
<td>VMware Virtual Hardware Version/Hypervisor</td>
<td>• VMware version 7 (default) for ESX/ESXi 4.x</td>
</tr>
<tr>
<td></td>
<td>• VMware version 8 (default) for ESXi 5.x</td>
</tr>
<tr>
<td></td>
<td>• VMware version 11 (default) for ESXi 6.0 (requires Cisco ISE 1.3 Patch 4)</td>
</tr>
</tbody>
</table>

### Related Topics

- Deployment Size and Scaling Recommendations
- Virtual Machine Appliance Size Recommendations, on page 6
- Disk Space Requirements, on page 8
- Configure a VMware Server, on page 16

## Virtual Machine Appliance Size Recommendations

Cisco ISE 2.4 introduces a large VM for Monitoring nodes. Deploying a Monitoring persona on a large VM offers the following advantages:

- Improves performance in terms of faster response to live log queries and report completion.
- Will be able to support the deployments that can handle more than 500,000 sessions when the support is provided in future ISE releases.

### Note

This form factor is available only as a VM in Release 2.4 and later, and requires a large VM license.

Keep the following guidelines in mind when allocating resources for the appliance:

- Failure to allocate the specified resources might result in performance degradation or service failure. We highly recommend that you deploy dedicated VM resources and not share or oversubscribe resources across multiple guest VMs. Deploying Cisco ISE virtual appliances using the OVF templates ensures that adequate resources are assigned to each VM. If you do not use OVF templates, then ensure that you assign the equivalent resource reservations when you manually install Cisco ISE using the ISO image.
If you choose to deploy Cisco ISE manually without the recommended reservations, you must assume the responsibility to closely monitor your appliance’s resource utilization and increase resources, as needed, to ensure proper health and functioning of the Cisco ISE deployment.

Note: OVF templates are not applicable for Linux KVM. OVF templates are available only for VMware virtual machines.

- If you are using the OVA templates for installation, check the following settings after the installation is complete:
  - Ensure that the CPU usage in the CPU Limit field (under the Virtual Hardware tab in the Edit Settings window) is set to Unlimited. Setting a limit for CPU usage (for example, setting the CPU usage limit as 12000 MHz) will impact the system performance. If limit has been set, you must shutdown the VM client, remove the limit, and the restart the VM client.
  - Ensure that the memory usage in the Memory Limit field (under the Virtual Hardware tab in the Edit Settings window) is set to Unlimited. Setting a limit for memory usage (for example, setting the limit as 12000 MB) will impact the system performance.

- Policy Service nodes on VMs can be deployed with less disk space than Administration or Monitoring nodes. The minimum disk space for any production Cisco ISE node is 200 GB. See Disk Space Requirements, on page 8 for details on the disk space required for various Cisco ISE nodes and personas.

- VMs can be configured with 1 to 4 NICs. The recommendation is to allow for 2 or more NICs. Additional interfaces can be used to support various services such as profiling, guest services, or RADIUS.

### Table 2: Minimum VM Appliance Specifications for a Production Environment

<table>
<thead>
<tr>
<th>Platform</th>
<th>Small VM Appliance (based on SNS-3415)</th>
<th>Large VM Appliance (based on SNS-3495)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>4 total cores (at 2.0 GHz or above)</td>
<td>8 total cores (at 2.0 GHz or above)</td>
</tr>
<tr>
<td>Note</td>
<td>You must enable hyperthreading and assign the resulting number of logical processors (8) to each server.</td>
<td>You must enable hyperthreading and assign the resulting number of logical processors (16) to each server.</td>
</tr>
<tr>
<td>Memory</td>
<td>16 GB</td>
<td>32 GB</td>
</tr>
<tr>
<td>Total Disk Space</td>
<td>200 GB—1.999 TB. See Disk Space Requirements, on page 8 for more information.</td>
<td>200 GB—1.999 TB. See Disk Space Requirements, on page 8 for more information.</td>
</tr>
<tr>
<td>Ethernet NICs</td>
<td>Up to 4 Gigabit Ethernet NICs</td>
<td>Up to 4 Gigabit Ethernet NICs</td>
</tr>
</tbody>
</table>
Disk Space Requirements

The following table lists the Cisco ISE disk-space allocation recommended for running a virtual machine in a production deployment.

<table>
<thead>
<tr>
<th>ISE Persona</th>
<th>Minimum Disk Space for Evaluation</th>
<th>Minimum Disk Space for Production</th>
<th>Recommended Disk Space for Production</th>
<th>Maximum Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone ISE</td>
<td>200 GB</td>
<td>600 GB</td>
<td>600 GB to 1.999 TB</td>
<td>1.999 TB</td>
</tr>
<tr>
<td>Distributed ISE—Administration only</td>
<td>200 GB</td>
<td>250 GB</td>
<td>250 to 300 GB</td>
<td>1.999 TB</td>
</tr>
<tr>
<td>Distributed ISE—Monitoring only</td>
<td>200 GB</td>
<td>600 GB</td>
<td>600 GB to 1.999 TB</td>
<td>1.999 TB</td>
</tr>
<tr>
<td>Distributed ISE—Policy Service only</td>
<td>200 GB</td>
<td>200 GB</td>
<td>200 GB</td>
<td>1.999 TB</td>
</tr>
<tr>
<td>Distributed ISE—pxGrid only</td>
<td>200 GB</td>
<td>200 GB</td>
<td>200 GB</td>
<td>1.999 TB</td>
</tr>
<tr>
<td>Distributed ISE—Administration and Monitoring (and optionally pxGrid)</td>
<td>200 GB</td>
<td>600 GB</td>
<td>600 GB to 1.999 TB</td>
<td>1.999 TB</td>
</tr>
<tr>
<td>Distributed ISE—Administration, Monitoring, and Policy Service (and optionally pxGrid)</td>
<td>200 GB</td>
<td>600 GB</td>
<td>600 GB to 1.999 TB</td>
<td>1.999 TB</td>
</tr>
</tbody>
</table>

Additional disk space is required to store local debug logs, staging files, and to handle log data during upgrade, when the Primary Administration Node temporarily becomes a Monitoring node.

**Disk Space Guidelines**

Keep the following guidelines in mind when deciding the disk space for Cisco ISE:

- You can allocate only up to 1.999 TB of disk space for a Cisco ISE VM.

---

**Note**

Disk size of 2 TB or greater is currently not supported. Ensure that the maximum disk size is less than 2 TB.
• Cisco ISE must be installed on a single disk in virtual machine.

• Disk allocation varies based on logging retention requirements. On any node that has the Monitoring persona enabled, 30 percent of the VM disk space is allocated for log storage. A deployment with 25,000 endpoints generates approximately 1 GB of logs per day.

For example, if you have a Monitoring node with 600-GB VM disk space, 180 GB is allocated for log storage. If 100,000 endpoints connect to this network every day, it generates approximately 4 GB of logs per day. In this case, you can store 38 days of logs in the Monitoring node, after which you must transfer the old data to a repository and purge it from the Monitoring database.

For extra log storage, you can increase the VM disk space. For every 100 GB of disk space that you add, you get 30 GB more for log storage. Depending on your requirements, you can increase the VM disk size up to a maximum of 1.999 TB of log storage.

If you increase the disk size of your virtual machine after initial installation, then you must perform a fresh installation of Cisco ISE on your virtual machine to properly detect and utilize the full disk allocation.

The following table lists the number of days that logs can be retained on your Monitoring node based on the allocated disk space and the number of endpoints that connect to your network. The numbers are based on having log suppression and anomalous client detection enabled.

Table 4: Days that Logs can be Stored in a Monitoring Node

<table>
<thead>
<tr>
<th>No. of Endpoints</th>
<th>200 GB</th>
<th>600 GB</th>
<th>1024 GB</th>
<th>2048 GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>10,000</td>
<td>126</td>
<td>378</td>
<td>645</td>
<td>1,289</td>
</tr>
<tr>
<td>20,000</td>
<td>63</td>
<td>189</td>
<td>323</td>
<td>645</td>
</tr>
<tr>
<td>30,000</td>
<td>42</td>
<td>126</td>
<td>215</td>
<td>430</td>
</tr>
<tr>
<td>40,000</td>
<td>32</td>
<td>95</td>
<td>162</td>
<td>323</td>
</tr>
<tr>
<td>50,000</td>
<td>26</td>
<td>76</td>
<td>129</td>
<td>258</td>
</tr>
<tr>
<td>100,000</td>
<td>13</td>
<td>38</td>
<td>65</td>
<td>129</td>
</tr>
<tr>
<td>150,000</td>
<td>9</td>
<td>26</td>
<td>43</td>
<td>86</td>
</tr>
<tr>
<td>200,000</td>
<td>7</td>
<td>19</td>
<td>33</td>
<td>65</td>
</tr>
<tr>
<td>250,000</td>
<td>6</td>
<td>16</td>
<td>26</td>
<td>52</td>
</tr>
</tbody>
</table>

**Increasing Disk Size**

If you find that context and visibility is slow, or you are running out of room for logs, you need to allocate more disk space.

To plan for additional log storage, for every 100 GB of disk space that you add, 60 GB is available for log storage. The maximum VM disk size is 1.999 TB.

In order for ISE to detect and utilize the new disk allocation, you must deregister the node, update the VM settings, and reinstall ISE. One way to do this is to install ISE on a new larger node, and add that node to the deployment as high availability. After the nodes have synchronized, make the new VM the primary and deregister the original VM.
Virtual Machine Resource and Performance Checks

Before installing Cisco ISE on a virtual machine, the installer performs hardware integrity checks by comparing the available hardware resources on the virtual machine with the recommended specifications.

During a VM resource check, the installer checks for the hard disk space, number of CPU cores allocated to the VM, CPU clock speed, and RAM allocated to the VM. If the VM resources do not meet the basic evaluation specifications, the installation aborts. This resource check is applicable only for ISO-based installations.

When you run the Setup program, a VM performance check is done, where the installer checks for disk I/O performance. If the disk I/O performance does not meet the recommended specifications, a warning appears on screen, but it allows you to continue with the installation. This performance verification check is applicable for both ISO-based and OVA (VMware) installations.

The VM performance check is done periodically (every hour) and the results are averaged for a day. If the disk I/O performance does not meet the recommended specification, an alarm is generated.

The VM performance check can also be done on demand from the Cisco ISE CLI using the `show tech-support` command.

The VM resource and performance checks can be run independent of Cisco ISE installation. You can perform this test from the Cisco ISE boot menu.

On-Demand Virtual Machine Performance Check Using the show tech-support Command

You can run the `show tech-support` command from the CLI to check the VM performance at any point of time. The output of this command will be similar to the following:

```
ise-vm123/admin# show tech | begin "disk IO perf"
Measuring disk IO performance
*****************************************
Average I/O bandwidth writing to disk device: 48 MB/second
Average I/O bandwidth reading from disk device: 193 MB/second
WARNING: VM I/O PERFORMANCE TESTS FAILED!
WARNING: The bandwidth writing to disk must be at least 50 MB/second,
WARNING: and bandwidth reading from disk must be at least 300 MB/second.
WARNING: This VM should not be used for production use until disk
WARNING: performance issue is addressed.
Disk I/O bandwidth filesystem test, writing 300 MB to /opt:
314572800 bytes (315 MB) copied, 7.81502 s, 40.3 MB/s
Disk I/O bandwidth filesystem read test, reading 300 MB from /opt:
314572800 bytes (315 MB) copied, 0.416897 s, 755 MB/s
```

Virtual Machine Resource Check from the Cisco ISE Boot Menu

You can check for virtual machine resources independent of Cisco ISE installation from the boot menu.

The CLI transcript appears as follows:

```
Welcome to the Cisco Identity Services Engine Installer
Cisco ISE Version: 1.3.0.299

Available boot options:
```
Enter boot option and press <Enter>.

From the CLI boot menu, enter 3 or 4 to go to the System Utilities menu.

Cisco ISE System Utilities Menu

Available System Utilities:

[1] Recover administrator password
[3] System Erase
[4] Install Media Check
[q] Exit and reload

Enter option and press <Enter>

Enter 2 to check for VM resources. The output will be similar to the following:

***** Virtual Machine host detected...
***** Hard disk(s) total size detected: 322 Gigabyte
***** Physical RAM size detected: 40443664 Kbytes
***** Number of network interfaces detected: 1
***** Number of CPU cores: 2
***** CPU Mhz: 2300.00
***** Verifying CPU requirement...
***** Verifying RAM requirement...
***** Writing disk partition table...

Obtain the Cisco ISE Evaluation Software

To obtain the Cisco ISE evaluation software (R-ISE-EVAL-K9=), contact your Cisco Account Team or your Authorized Cisco Channel Partner.

To migrate a Cisco ISE configuration from an evaluation system to a fully licensed production system, you need to complete the following tasks:

• Back up the configuration of the evaluation version.

• Ensure that your production VM has the required amount of disk space. See Deployment Size and Scaling Recommendations for details.

• Install a production deployment license.

• Restore the configuration to the production system.

Note

For evaluation, the minimum allocation requirements for a hard disk on a VM is 200 GB. When you move the VM to a production environment that supports a larger number of users, be sure to reconfigure the Cisco ISE installation to the recommended minimum disk size or higher (up to the allowed maximum of 1.999 TB).
Before you begin

For evaluation purposes, Cisco ISE can be installed on any supported VMs that complies with the VM requirements. When evaluating Cisco ISE, you can configure less disk space in the VM, but you must allocate a minimum disk space of 200 GB.

---

**Step 1**
Go to http://www.cisco.com/go/ise. You must already have valid Cisco.com login credentials to access this link.

**Step 2**
Click **Download Software for this Product**.

The software image comes with a 90-days evaluation license already installed, so you can begin evaluating all Cisco ISE services when the installation and initial configuration are complete.

---

**Related Topics**

Virtual Machine Requirements, on page 3

---

**Install Cisco ISE on Virtual Machines**

You can install Cisco ISE on VMs in any one of the following ways. We recommend that you download and deploy Cisco ISE OVA templates.

- **Deploy Cisco ISE on Virtual Machines Using OVA Templates**, on page 12
- **Install Cisco ISE on Virtual Machines Using the ISO File**, on page 13
- **Clone a Cisco ISE Virtual Machine**, on page 19

---

**Deploy Cisco ISE on Virtual Machines Using OVA Templates**

You can use OVA templates to install and deploy Cisco ISE software on a virtual machine. Download the OVA template from Cisco.com.

---

**Before you begin**

---

**Note**

The ISE OVA templates are not compatible with VMware web client for vCenter 6.5. As a workaround, use the VMware OVF tool to import the OVA templates.

You must reimage Cisco ISE from ISO if the virtual hard disk is resized after importing the OVA, as Cisco ISE does not support resizing hard disk and file systems after installation.

---

**Step 1**
Open **VMware vSphere** client.

**Step 2**
Log in to VMware host.

**Step 3**
Choose **File > Deploy OVF Template** from the VMware vSphere Client.

**Step 4**
Click **Browse** to select the OVA template, and click **Next**.

**Step 5**
Confirm the details in the OVF Template Details page, and click **Next**.
Install Cisco ISE on Virtual Machines Using the ISO File

To install Cisco ISE on a VM using the ISO file:

Before you begin

- Ensure that you read and allocate VM resources according to the requirements specified in this chapter.
- Ensure that you have read the Prerequisites for Configuring a VMware ESX or ESXi Server, on page 13 section.
- Download the Cisco ISE ISO image from Cisco.com.

Step 1 Configure a VMware server. See Configure a VMware Server, on page 16.
Step 2 Configure a VMware system to boot from a software DVD. See Configure a VMware System to Boot From a Cisco ISE Software DVD, on page 17.
Step 3 Install Cisco ISE software on the VM. See Cisco ISE Setup Program Parameters

Prerequisites for Configuring a VMware ESX or ESXi Server

Review the following configuration prerequisites listed in this section before you attempt to configure a VMware ESX or ESXi server:

- Remember to log in to the ESX or ESXi server as a user with administrative privileges (root user).

- Cisco ISE is a 64-bit system. Before you install a 64-bit system, ensure that Virtualization Technology (VT) is enabled on the ESX or ESXi server. You must also ensure that your guest operating system type is set to Red Hat Enterprise Linux 6 (64-bit).

- For Red Hat Enterprise Linux 6, the default NIC type is VMXNET3 Adapter. You can add up to four NICs for your Cisco ISE virtual machine, but ensure that you choose the same Adapter for all the NICs. Cisco ISE supports the E1000 Adapter.
If you choose the default network driver (VMXNET3) as the Network Adapter, check the physical adapter mappings. Ensure that you map the Cisco ISE GigabitEthernet 0 interface to the 4th interface (NIC 4) in ESX or ESXi server. If you choose the E1000 Adapter, by default, the ESX or ESXi adapters and Cisco ISE adapters are mapped correctly.

- Ensure that you allocate the recommended amount of disk space on the VMware virtual machine. See the Disk Space Requirements, on page 8 section for more information.

- If you have not created a VMware virtual machine file system (VMFS), you must create one to support the Cisco ISE virtual appliance. The VMFS is set for each of the storage volumes configured on the VMware host.
  - If you use VMFS5, the 1-MB block size supports up to 1.999 TB virtual disk size.
  - If you use VMFS3, you must choose a VMFS block size based on the largest virtual-disk size hosted on the VMware host. After you configure the VMFS block size, you cannot change it without reformatting the VMFS partitions. For VMFS3, the VMFS block size should be based on the size of the largest virtual disk:

<table>
<thead>
<tr>
<th>Table 5: VMFS Block Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Size</td>
</tr>
<tr>
<td>1 MB</td>
</tr>
<tr>
<td>2 MB</td>
</tr>
<tr>
<td>4 MB</td>
</tr>
<tr>
<td>8 MB</td>
</tr>
</tbody>
</table>

Related Topics
- Disk Space Requirements, on page 8
- Configure VMware Server Interfaces for the Cisco ISE Profiler Service, on page 15
- Enable Virtualization Technology on an ESX or ESXi Server, on page 15

Virtualization Technology Check

If you have an ESX or ESXi server installed already, you can check if VT is enabled on it without rebooting the machine. To do this, use the `esxcfg-info` command. Here is an example:

```bash
+ # esxcfg-info |grep "HV Support"
|----HV Support............................................3
|----World Command Line....................................grep HV Support
```

If HV Support has a value of 3, then VT is enabled on the ESX or ESXi server and you can proceed with the installation.

If HV Support has a value of 2, then VT is supported, but not enabled on the ESX or ESXi server. You must edit the BIOS settings and enable VT on the ESX or server.
Enable Virtualization Technology on an ESX or ESXi Server

You can reuse the same hardware that you used for hosting a previous version of Cisco ISE virtual machine. However, before you install the latest release, you must enable Virtualization Technology (VT) on the ESX or ESXi server.

Step 1  Reboot the SNS-3400 series appliance.
Step 2  Press F2 to enter setup.
Step 3  Choose Advanced > Processor Configuration.
Step 4  Select Intel(R) VT and enable it.
Step 5  Press F10 to save your changes and exit.

Configure VMware Server Interfaces for the Cisco ISE Profiler Service

Configure VMware server interfaces to support the collection of Switch Port Analyzer (SPAN) or mirrored traffic to a dedicated probe interface for the Cisco ISE Profiler Service.

Step 1  Choose Configuration > Networking > Properties > VMNetwork (the name of your VMware server instance) VMswitch0 (one of your VMware ESX or ESXi server interfaces) Properties Security.
Step 2  In the Policy Exceptions pane on the Security tab, check the Promiscuous Mode check box.
Step 3  In the Promiscuous Mode drop-down list, choose Accept and click OK.
Repeat the same steps on the other VMware ESX or ESXi server interface used for profiler data collection of SPAN or mirrored traffic.

Connect to the VMware Server Using the Serial Console

Step 1  Power down the particular VMware server (for example ISE-120).
Step 2  Right-click the VMware server and choose Edit.
Step 3  Click Add on the Hardware tab.
Step 4  Choose Serial Port and click Next.
Step 5  In the Serial Port Output area, click the Use physical serial port on the host or the Connect via Network radio button and click Next.

• If you choose the Connect via Network option, you must open the firewall ports over the ESX or ESXi server.

• If you select the Use physical serial port on the host, choose the port. You may choose one of the following two options:

  • /dev/ttyS0 (In the DOS or Windows operating system, this will appear as COM1).
  • /dev/ttyS1 (In the DOS or Windows operating system, this will appear as COM2).

Step 6  Click Next.
Step 7  In the Device Status area, check the appropriate check box. The default is Connected.

Step 8  Click OK to connect to the VMware server.

## Configure a VMware Server

### Before you begin
Ensure that you have read the details in the Prerequisites for Configuring a VMware ESX or ESXi Server, on page 13 section.

### Step 1
Log in to the ESX or ESXi server.

### Step 2
In the VMware vSphere Client, in the left pane, right-click your host container and choose New Virtual Machine.

### Step 3
In the Configuration dialog box, choose Custom for the VMware configuration and click Next.

### Step 4
Enter a name for the VMware system and click Next.

**Tip**  Use the hostname that you want to use for your VMware host.

### Step 5
Choose a datastore that has the recommended amount of space available and click Next.

### Step 6
(Optional) If your VM host or cluster supports more than one VMware virtual machine version, choose a Virtual Machine version such as Virtual Machine Version 7, and click Next.

### Step 7
Choose Linux and Red Hat Enterprise Linux 6 (64-bit) from the Version drop-down list.

### Step 8
Choose 2 from the Number of virtual sockets and the Number of cores per virtual socket drop-down list. Total number of cores should be 4.

(Optional; appears in some versions of ESX or ESXi server. If you see only the Number of virtual processors, choose 4).

### Step 9
Choose the amount of memory and click Next.

### Step 10
Choose the E1000 NIC driver from the Adapter drop-down list and click Next.

**Note**  We recommend that you select E1000 to ensure correct adapter order by default. If you choose VMXNET3, you might have to remap the ESXi adapter to synchronize it with the ISE adapter order.

### Step 11
Choose Paravirtual as the SCSI controller and click Next.

### Step 12
Choose Create a new virtual disk and click Next.

### Step 13
In the Disk Provisioning dialog box, click Thick Provision radio button, and click Next to continue.

Cisco ISE supports both thick and thin provisioning. However, we recommend that you choose thick provisioning for better performance, especially for Monitoring nodes. If you choose thin provisioning, operations such as upgrade, backup and restore, and debug logging that require more disk space might be impacted during initial disk expansion.

### Step 14
Uncheck the Support clustering features such as Fault Tolerance check box.

### Step 15
Choose the advanced options, and click Next.

### Step 16
Verify the configuration details, such as Name, Guest OS, CPUs, Memory, and Disk Size of the newly created VMware system. You must see the following values:

- Guest OS—Red Hat Enterprise Linux 6 (64-bit)
For the Cisco ISE installation to be successful on a virtual machine, ensure that you adhere to the recommendations given in this document.

**Step 17**  
Click **Finish**.

The VMware system is now installed.

---

**What to do next**

To activate the newly created VMware system, right-click VM in the left pane of your VMware client user interface and choose **Power > Power On**.

**Related Topics**

- [Virtual Machine Appliance Size Recommendations](#), on page 6  
- [Disk Space Requirements](#), on page 8

---

**Increase Virtual Machine Power-On Boot Delay Configuration**

On a VMware virtual machine, the boot delay by default is set to 0. You can change this boot delay to help you choose the boot options (while resetting the Administrator password, for example).

**Step 1**  
From the VSphere client, right click the VM and choose **Edit Settings**.

**Step 2**  
Click the **Options** tab.

**Step 3**  
Choose **Advanced > Boot Options**.

**Step 4**  
From the **Power on Boot Delay** area, select the time in milliseconds to delay the boot operation.

**Step 5**  
Check the check box in the **Force BIOS Setup** area to enter into the BIOS setup screen when the VM boots the next time.

**Step 6**  
Click **OK** to save your changes.

---

**Configure a VMware System to Boot From a Cisco ISE Software DVD**

After configuring the VMware system, you are ready to install the Cisco ISE software. To install the Cisco ISE software from a DVD, you need to configure the VMware system to boot from it. This requires the VMware system to be configured with a virtual DVD drive.

**Before you begin**

You must download the Cisco ISE ISO, burn the ISO image on a DVD, and use it to install Cisco ISE on the virtual machine.

**Step 1**  
In the VMware client, highlight the newly created VMware system and choose **Edit Virtual Machine Settings**.
Step 2  In the Virtual Machine Properties dialog box, choose **CD/DVD Drive 1**.
Step 3  Click the **Host Device** radio button and choose the DVD host device from the drop-down list.
Step 4  Choose the **Connect at Power On** option and click **OK** to save your settings.

You can now use the DVD drive of the VMware ESX or ESXi server to install the Cisco ISE software.

---

**What to do next**

After you complete this task, click the **Console** tab in the VMware client user interface, right-click VM in the left pane, choose **Power**, and choose **Reset** to restart the VMware system.

---

**Install Cisco ISE Software on a VMware System**

**Before you begin**

• After installation, if you do not install a permanent license, Cisco ISE automatically installs a 90-day evaluation license that supports a maximum of 100 endpoints.


---

Step 1  Log in to the VMware client.
Step 2  For the virtual machine to enter the BIOS setup mode, right click the VM and click **Edit Settings**.
Step 3  Click the **Options** tab.
Step 4  Select **Boot Options** and configure the following option:
   a) In the **Force BIOS Setup** area, check the check box to enter the BIOS setup screen when the virtual machine boots.
Step 5  Click **OK**.
Step 6  Ensure that the Coordinated Universal Time (UTC) and the correct boot order is set in BIOS:
   a) If the virtual machine is turned on, turn the system off.
   b) Turn on the virtual machine.
      The system enters the BIOS setup mode.
   c) In the Main BIOS menu, using the arrow keys, navigate to the Date and Time field and press **Enter**.
   d) Enter the UTC/Greenwich Mean Time (GMT) time zone.
      This time zone setting ensures that the reports, logs, and posture-agent log files from the various nodes in your deployment are always synchronized with regard to the time stamps.
   e) Using the arrow keys, navigate to the Boot menu and press **Enter**.
   f) Using the arrow keys, select CD-ROM Drive and press + to move the CD-ROM drive up the order.
   g) Using the arrow keys, navigate to the Exit menu and choose **Exit Saving Changes**.
   h) Choose **Yes** to save the changes and exit.
Step 7  Insert the Cisco ISE software DVD into the VMware ESX or ESXi host CD/DVD drive and turn on the virtual machine.
When the DVD boots, the console displays:
Welcome to the Cisco Identity Services Engine Installer
Cisco ISE Version: 1.3.0.802

Available boot options:
[1] Cisco ISE Installation (Keyboard/Monitor)
[2] Cisco ISE Installation (Serial Console)
[3] System Utilities (Keyboard/Monitor)
[4] System Utilities (Serial Console)
<Enter> Boot existing OS from hard disk.

Enter boot option and press <Enter>.

boot: 1
Loading vmlinuz......
Loading initrd.img...............................................ready.
Initializing cgroup subsys cpuset
Initializing cgroup subsys cpu
Linux version 2.6.32-431.el6.x86_64 (mockbuild@x86-023.build.eng.bos.redhat.com) (gcc version 4.4.7 20120313 (Red Hat 4.4.7-4) (GCC) ) #1 SMP Sun Nov 10 22:19:54 EST 2013

Step 8
At the system prompt:

• Enter 1 to install Cisco ISE using a keyboard and a monitor.
• Enter 2 to install Cisco ISE using a serial console. This option requires that you have a serial console set up on your virtual machine. Refer to the VMware vSphere Documentation for information on how to create a console.

The installer starts the installation of the Cisco ISE software on the VMware system. Allow 20 minutes for the installation process to complete. When the installation process finishes, the virtual machine reboots automatically. When the VM reboots, the console displays:

Type 'setup' to configure your appliance
localhost:

Step 9
At the system prompt, type setup and press Enter.
The Setup Wizard appears and guides you through the initial configuration.

Related Topics
Cisco ISE Setup Program Parameters

Cisco ISE ISO Installation on Virtual Machine Fails
If a fresh installation of Cisco ISE on a virtual machine fails, and you have the default network driver (VMXNET3) chosen as the Network Adapter, check the physical adapter mappings. Ensure that you map the Cisco ISE GigabitEthernet0 interface to the 4th interface (NIC 4) in ESX or ESXi. The workaround is to use the E1000 driver as the Network Adapter.

Clone a Cisco ISE Virtual Machine
You can clone a Cisco ISE VMware virtual machine (VM) to create an exact replica of a Cisco ISE node. For example, in a distributed deployment with multiple Policy Service nodes (PSNs), VM cloning helps you deploy the PSNs quickly and effectively. You do not have to install and configure the PSNs individually.
You can also clone a Cisco ISE VM using a template.
For cloning, you need VMware vCenter. Cloning must be done before you run the Setup program.

**Before you begin**

- Ensure that you shut down the Cisco ISE VM that you are going to clone. In the vSphere client, right-click the Cisco ISE VM that you are about to clone and choose **Power > Shut Down Guest**.
- Ensure that you change the IP Address and Hostname of the cloned machine before you power it on and connect it to the network.

**Step 1**
Log in to the ESX or ESXi server as a user with administrative privileges (root user).
VMware vCenter is required to perform this step.

**Step 2**
Right-click the Cisco ISE VM you want to clone, and click **Clone**.

**Step 3**
Enter a name for the new machine that you are creating in the Name and Location dialog box and click **Next**.
This is not the hostname of the new Cisco ISE VM that you are creating, but a descriptive name for your reference.

**Step 4**
Select a Host or Cluster on which you want to run the new Cisco ISE VM and click **Next**.

**Step 5**
Select a datastore for the new Cisco ISE VM that you are creating and click **Next**.
This datastore could be the local datastore on the ESX or ESXi server or a remote storage. Ensure that the datastore has enough disk space.

**Step 6**
Click the **Same format as source** radio button in the Disk Format dialog box and click **Next**.
This option copies the same format that is used in the Cisco ISE VM that you are cloning this new machine from.

**Step 7**
Click the **Do not customize** radio button in the Guest Customization dialog box and click **Next**.

**Step 8**
Click **Finish**.

**What to do next**

- Change the IP Address and Hostname of a Cloned Virtual Machine
- Connect a Cloned Cisco Virtual Machine to the Network

**Related Topics**

- Clone a Cisco ISE Virtual Machine Using a Template, on page 20
- Virtual Machine Requirements, on page 3
- Disk Space Requirements, on page 8

**Clone a Cisco ISE Virtual Machine Using a Template**

If you are using vCenter, then you can use a VMware template to clone a Cisco ISE virtual machine (VM). You can clone the Cisco ISE node to a template and use that template to create multiple new Cisco ISE nodes. Cloning a virtual machine using a template is a two-step process:
Create a Virtual Machine Template

Before you begin

Note
For cloning, you need VMware vCenter. Cloning must be done before you run the Setup program.

Step 1 Create a Virtual Machine Template, on page 21
Step 2 Deploy a Virtual Machine Template, on page 21

Create a Virtual Machine Template

Before you begin

- Ensure that you shut down the Cisco ISE VM that you are going to clone. In the vSphere client, right-click the Cisco ISE VM that you are about to clone and choose Power > Shut Down Guest.
- We recommend that you create a template from a Cisco ISE VM that you have just installed and not run the setup program on. You can then run the setup program on each of the individual Cisco ISE nodes that you have created and configure IP address and hostnames individually.

Step 1 Log into the ESX or ESXi server as a user with administrative privileges (root user).
VMware vCenter is required to perform this step.
Step 2 Right-click the Cisco ISE VM that you want to clone and choose Clone > Clone to Template.
Step 3 Enter a name for the template, choose a location to save the template in the Name and Location dialog box, and click Next.
Step 4 Choose the ESX or ESXi host that you want to store the template on and click Next.
Step 5 Choose the datastore that you want to use to store the template and click Next.
Ensure that this datastore has the required amount of disk space.
Step 6 Click the Same format as source radio button in the Disk Format dialog box and click Next.
The Ready to Complete dialog box appears.
Step 7 Click Finish.

Deploy a Virtual Machine Template

After you create a virtual machine template, you can deploy it on other virtual machines (VMs).

Step 1 Right-click the Cisco ISE VM template that you have created and choose Deploy Virtual Machine from this template.
Step 2 Enter a name for the new Cisco ISE node, choose a location for the node in the Name and Location dialog box, and click Next.
Step 3 Choose the ESX or ESXi host where you want to store the new Cisco ISE node and click Next.
Step 4  Choose the datastore that you want to use for the new Cisco ISE node and click **Next**.

Ensure that this datastore has the required amount of disk space.

Step 5  Click the **Same format as source** radio button in the Disk Format dialog box and click **Next**.

Step 6  Click the **Do not customize** radio button in the Guest Customization dialog box.

The Ready to Complete dialog box appears.

Step 7  Check the **Edit Virtual Hardware** check box and click **Continue**.

The Virtual Machine Properties page appears.

Step 8  Choose **Network adapter**, uncheck the **Connected** and **Connect at power on** check boxes, and click **OK**.

Step 9  Click **Finish**.

You can now power on this Cisco ISE node, configure the IP address and hostname, and connect it to the network.

---

**What to do next**

- Change the IP Address and Hostname of a Cloned Virtual Machine
- Connect a Cloned Cisco Virtual Machine to the Network

**Related Topics**

Clone a Cisco ISE Virtual Machine Using a Template, on page 20
Disk Space Requirements, on page 8

---

**Change the IP Address and Hostname of a Cloned Virtual Machine**

After you clone a Cisco ISE virtual machine (VM), you have to power it on and change the IP address and hostname.

**Before you begin**

- Ensure that the Cisco ISE node is in the standalone state.
- Ensure that the network adapter on the newly cloned Cisco ISE VM is not connected when you power on the machine. Uncheck the **Connected** and **Connect at power on** check boxes. Otherwise, if this node comes up, it will have the same IP address as the source machine from which it was cloned.
Figure 1: Disconnecting the Network Adapter

- Ensure that you have the IP address and hostname that you are going to configure for the newly cloned VM as soon as you power on the machine. This IP address and hostname entry should be in the DNS server. You cannot use "localhost" as the hostname for a node.
- Ensure that you have certificates for the Cisco ISE nodes based on the new IP address or hostname.

Procedure

Step 1 Right-click the newly cloned Cisco ISE VM and choose **Power > Power On**.

Step 2 Select the newly cloned Cisco ISE VM and click the **Console** tab.

Step 3 Enter the following commands on the Cisco ISE CLI:

```bash
configure terminal
hostname hostname
```

The hostname is the new hostname that you are going to configure. The Cisco ISE services are restarted.

Step 4 Enter the following commands:

```bash
interface gigabit 0
ip address ip_address netmask
```

The `ip_address` is the address that corresponds to the hostname that you entered in step 3 and `netmask` is the subnet mask of the `ip_address`. The system will prompt you to restart the Cisco ISE services. See the *Cisco Identity Services Engine CLI Reference Guide*, for the `ip address` and `hostname` commands.

Step 5 Enter **Y** to restart Cisco ISE services.
Connect a Cloned Cisco Virtual Machine to the Network

After you power on and change the ip address and hostname, you must connect the Cisco ISE node to the network.

Step 1
Right-click the newly cloned Cisco ISE virtual machine (VM) and click **Edit Settings**.

Step 2
Click **Network adapter** in the Virtual Machine Properties dialog box.

Step 3
In the Device Status area, check the **Connected** and **Connect at power on** check boxes.

Step 4
Click **OK**.

Migrate Cisco ISE VM from Evaluation to Production

After evaluating the Cisco ISE release, you can migrate the from an evaluation system to a fully licensed production system.

**Before you begin**

- When you move the VMware server to a production environment that supports a larger number of users, be sure to reconfigure the Cisco ISE installation to the recommended minimum disk size or higher (up to the allowed maximum of 1.999 TB).

- Please note that you cannot migrate data to a production VM from a VM created with less than 200 GB of disk space. You can only migrate data from VMs created with 200 GB or more disk space to a production environment.

Step 1
Back up the configuration of the evaluation version.

Step 2
Ensure that your production VM has the required amount of disk space.

Step 3
Install a production deployment license.

Step 4
Restore the configuration to the production system.

**Related Topics**

Deployment Size and Scaling Recommendations